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Logging In

Access the site by using the following web address:

Enter Gallery Username = Enter Gallery Password = Select Sign In

Log In

@
a e rI es Please use your windows credentials to sign in...

User Name: wwhirmingham

S i g n I n Password: «eeesesne

’ v Signln

Enter PIN (this is issued when joining the company) = Select
Sign In

Log In

&
Ga e rl es Please enter your Cybertill PIN number...

Sign In ‘ V SignIn
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http://gallery.theartbook.org/

Home Screen

Once logged in, the home screen will be displayed. The screen will appear blank until the curser is hovered over the left
hand side of the screen:

Petit jonathan ¥ e Petit jonathan v

= | &

Limited
My Originals Editions

-
=T
My Limiteds Retail Originals

I The pop up menu will be displayed: i

The below options will be visible:

» My Originals
» Retails Originals
» My Limiteds
» Limited Editions
» Private Views
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My Originals and My Limiteds

When selecting My Originals or My Limiteds a pop up box is displayed. This shows all originals or limiteds that are
currently in your gallery. Selecting these items will also allow access to imagery and details on the following artwork:

» Artwork that has been allocated to your gallery by your Merchandising Co-ordinator, which will be arriving at your
gallery on future deliveries

» All exhibition stock that is on offer to your gallery for forthcoming events

» Originals and limiteds that your gallery has previously sold (This is beneficial when completing valuation certificates
or viewing artwork that clients have previously purchased)
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Retail Originals and Limited Editions

When selecting Originals or Limited Editions a pop up box is displayed. This allows access to all available originals and
limited editions within the group.
» Selecting these items will allow access to imagery and artwork details

» You will be required to enter search parameters to render the results for your query, for example, filtering the
artwork by artist, budget, size or genre

» Any artwork that is currently allocated to exhibition will not be displayed, unless it is allocated to your gallery as
exhibition
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Filtering

The filtering function can be used once one of the following options has been selected: My Originals, Retail Originals, My
Limited’s and Limited Editions. Filtering is required, to render results, this then accurately finds specific types of artwork
to meet the requirements of your clients (If searching for limited editions, filter by Product Code and Created Date is also

an option):

The Filtering option is allocated on the top header bar:

Selected Filters Reset 38
|
Artist W
Dimensio hd
Pricing w
Colour n
Keywords =
Genre S
Attributes w7
Originals
Y Filters Views = Print Grid = Price Labels [ Select Al m M Celumns B . .
< ) The Filter drop down menu will be displayed -
fFD%N\ontfort



Title Filter

When selecting ‘Common’ from the filter YFilters £ Views | = Print Gri
menu, two fields are displayed; Barcode and Selected Filters Reset B
Title: 150 stack |
Barcode (| common
Bar Code:
If you know the product barcode and wish to |
check availability or need to confirm the :> e
imagery details = Enter the barcode into the Add )
Barcode field - Select Add - Select Apply Artist v
Filters Location v
Stock ¥
m Dimensions ¥
If you know the title of the artwork and wish to Attributes E
check availability or need to confirm the Pricing E
imagery details = Enter the title of the artwork e v
into the Title field = Select Add - Select E v
Apply Filters e N
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Artist Filter
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When selecting ‘Artist’ from the filter menu, three fields are displayed;
Artist, Artwork Style and Exclude Artist:

Artist

If you wish to search the database by a specific artist 2 Enter the artist
name into the Artist field (as you type a drop down box will be
displayed) = Select the correct artist 2 Select Add - Select Apply
Filters

Artwork Style

This option can only be selected once an artist has been selected (e.g. By
selecting Fabian Perez as the artist, the option to select ‘styles’ such as
balcony, tango and still life will be available). Multiple styles can be
selected - Select Add > Select Apply Filters

Exclude Artist

If you wish to exclude a specific artist from your search = Select the
drop down box from the Exclude Artist field = Select the artist 2 Select
Add - Select Apply Filters

=)

R

Y Filters L Views
Selected Filters

Is in stock

Common

— s o —

= Print Grid

Reset g

L

Artist:

Artwork Style:

Exclude Artist:

Location
Stock
Dimensions
Attributes
Pricing
Keywords
Colour

Genre
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Dimensions Filter
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When selecting ‘Dimensions’ from the filter menu, four
fields are displayed; Size, Width, Height and Orientation

Size

Select the drop down box from the Size field = Select the
specific size of artwork = Select Add = Select Apply
Filters

Width and Height

If you wish to search for a specific size of artwork =2 Enter
the size (inches) into the Inches fields = Select the
required option from the drop down box - Select Add -
Select Apply Filters

Orientation

Tick the required orientation = Select Add = Select Apply
Filters

Y Filters L Views

= Print Grig

Selected Filters Reset |36
Is in stock =
_-.-._
Common ¥
Artist b
Location &
Stock -4

) -
Size:
v
Width:

Is less than or equal to
inches
Height:
Is less than or equal to
inches
Crientation:
Landscape
Portrait

Square

< Add :
Attributes

Pricing
Keywords

Colour

manrs
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Pricing Filter

T Filters £ Views = Print Gri

Selected Filters Reset (3
Is in stack %

> Drag the slider to select a minimum and Mk ’
maximum price bracket = Select Add - Artist B
Select Apply Filters Location v
Stock v

» Use the left and right keys on your Dimensions v
keyboard for more gradual movements Attributes v

(£100 at a time) (M

Range: £7,700 - £30,000

Keywords ¥
Colour ¥
Genre ¥
E 3 FDr;:ﬂMontfort
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Colour Filter
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» Select a colour from the drop down box
- Select Add - Select Apply Filters

T Filters £ Views | = Print Gri
Selected Filters Reset |36

Is in stock &

Common ¥
Artist ¥
Location e
Stock ¥
Dimensions ¥
Attributes B
Pricing B
Keywords !

Genre ¥

E 3 FDr}:;:ﬂMoni‘.fort



Keywords Filter
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When selecting ‘Keywords’ from the filter menu, two
fields are displayed; Contains and Matches

Contains

This search will return partial matches, for example, If
‘Car’ is entered into the Contains field, artwork with
words containing the letters C A R in that order will be
displayed, such as carp and scar. Enter the specific
word into the Contains field = Select Add = Select
Apply Filters

Matches

This search will return only full matches, for example, If
‘Car’ is entered into the Matches field, only artwork
with the word Car will be displayed. Enter the specific
word into the Matches field 2 Select Add - Select
Apply Filters

T Filters LF Views
Selected Filters

Is im stock

Common
Artist
Location
Stock
Dimensions
Attributes

Pricing

__

= Print Gri
Reset *
&

L

=

Contains:

Matches:

Colour

Genre
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Genre Filter

When selecting ‘Genre’ from the filter menu, three
fields are displayed; Style, Subject and Medium

Style

Select the drop down box = Select the required style of
artwork (e.g. abstract or impressionist) = Select Add —
Select Apply Filters

Subject

Select the drop down box = Select the required subject
of the artwork (e.g. cityscape or figurative) = Select
Add - Select Apply Filters

Medium

Select the drop down box = Select the required
medium (e.g. oil or paint) = Select Add > Select Apply

T Filters LF Views = Print Gni
Selected Filters Feset |38
Is in stock =

_i.ﬂ_

Commaon "’

Artist ¥

Location b

Stock b

Dimensions "’

Attributes '

Pricing i

Keywords &

Colour s

——
Style:
v
Subject:
v
Medium:

Add >

Filters

€ DeMontfort
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Saving a View

Once you have searched for your required artwork, you are able to save the view for future reference, for example, If you
wish to see if any new artwork is added using the same search criteria

e

< Y Filters >ﬂ-‘-.-‘iew5 = Print
+ {3

From the top header bar = Select Views = Select the + icon Standard Views

Artwork that is in stock

Your Views

Save this view... x

. Please provide a name for this view:
Enter a name for the ‘View’ > Select Accept <:|

Dough Hyde

< o Accept
] T Filters L Views = Print {
+

Standard Views

Artwork that is in stock

Your Views

The saved view will then be displayed under the Views tab Doug Hyde <::I
fFD%N\ontfort
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Header Bar

There are several tabs along the header bar that can be dragged and dropped into the space provided, to enable you to
sort and group the artwork into a specific order (e.g. sort by artist, retail price or location)

[Originals (Retail)
¥ riters gviews | = print Grid | @ selectal | [ | B | micoumns

~ Location X

‘Zmage ‘ Barcode | Description ‘ Artist ‘ Size ‘ ‘Width ‘ Height | Finish ‘ Format | Produced On | Retail Price | Medium

4 Location: U3 Goods in

The example on the right is a search for Paul James
<:| Originals; this has then been sorted by location, by
dragging the Location tab into the space provided

22x22 22x18

52x44

+ Location: Whitewall Kingston

14x14

+ Location: Whitewall Leamington Spa

36x36

4 Location: Whitewall Liverpool

n

€ DeMontfort
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Viewing a Product (Originals)

Larger images and artwork details can be displayed by double clicking on the image:

Hebridean Vista
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General

Barcode:
Title:

Artist:

Size:
Location:
Status:
Price:
Edition No.:

Attributes

Finish:
Format:
Process:
Produced On:
Class:

Type:
Keywords:

Mediums:
Artwork Style:
Colours:

Styles:

Subjects:

Detail Level:
Collection:
Friendly
Description:
Additional Info.:

1518670
Hebridean Vista
Lynn Rodgie
30" x 30" (76.1cm x Q2
Fulfilment Racking
FRAMED

£2,950

0

N/A
Stretched
By Hand
Canvas
Original
Painting
house pond scotland fields
countryside

Cil

LANDSCAPE

Blue, Orange, White
Contemporary

Landscape

PRINCIPAL

CLASSIC

Original Painting on Stretched
Canvas

YVVVYVY

YVVVYY

The below information will be displayed:

Barcode of the piece

Title of the piece

Artist

Size

Location (If in HQ, Fulfilment or
Originals Racking will be displayed)
Status (Framed or unframed)
Price

Glazed or not glazed

Medium

Keywords

Attributes

A print and email option is also available from
this screen

€ DeMontfort
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Viewing a Product (Limited Editions)

Larger images and artwork details can be displayed by double clicking on the image (Additional information for Limited

Editions will be displayed):

The Messengers

[x]

General

=)&) <)

Printable Quantity = How many
are left to print

Code: LDAKO69
Messengers

Title: The
Artist:

Size:

Status:

Price:
Printable Qty:
Local Qty:
SOP Qty:

New Release: Yes

Available Qty: 53 \
Edition Size: 195\

Local Quantity = How many are
at HQ

Attributes \ 0
Finish: N/A N
Format: On Board

Process: Giclee

Produced On: Paper

Class: Limited Edition Purchased
Type: Print

Keywords: animals tree stag nature
Mediums: Mixed Media

Artwork Style: TREE OF LIFE

Colours: Blue,Multicoloured,Purple Red
Styles: Contemporary

Subjects: Animals,Nature

Detail Level:

Collection: CLASSIC

Friendly Description:

Additional Info.:

SOP (Sales Order Processing)
Quantity = How many are on
order

Available Quantity = How
many are available in total

19

€ DeMontfort

FineArt




Emailing a Client

Imagery and imagery details can be emailed direct to a client:

Select the required artwork = Hold CTRL and left click on the image/s = Right click on a selected image = Select Email

Create new email... X
: 53 Email Email To: i i
2 : | Manually add addresses ¥ |
b creace Private View 7
A Mark as Sold Products
Y Filters | Il Columns By O
Image | Barcode ¥ Code | Description | Location | Artist l Channel | Width I
Height | Price
A
O 71 H
f T..?r 5\ L
Confirm the images selected are correct = Select Generate Email - —
o« O | 125 v | items per page 1-3of3items
The imagery selected will be displayed in an email
v
€ DeMontfort
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Creating a Private View

Private views for specific clients can be created:

Select the required artwork = Hold CTRL and left click on the image/s = Right click on a selected image = Select Create

Private View

o\

A

View

Create Private View
Mark as Sold

D

21

If you would like to link a private view to a client on the CRM,

Add / remove products to be e-mailed to leanne medley... x
L Views | = Print Grid M Columns o)
Image Comments Description Artist
‘ i | Dog and Hedgehog  (Doug Hyde £ x
AN
8 i Study
4x2
» e Duck Egg Study Doug Hyde SIx
Mgt
“I%3
‘ w Cow Portrait Study Doug Hyde £ x
%3

Specify a customer... | x|
|. Enter name...
Please select an existing customer ..,
- OF Creste a new ane:
Customer Name: Leanne Medley ‘
Primary Gallery: Whitewall Lichfield v |
Consultant Name: Hizabeth Grant A 1
Email Address: medley123@hotmail.com
Telephone:
Pastcode:
O Send email 7
Please select the expiry date for this allocation:
25/06/2018 ]
4 Ba |m|

-leack + Finish

Enter the clients name and an email address = Select Next

enter the clients name in the Existing Customer field = Click on
the correct client - Select Next

Select Finish

€ DeMontfort
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Viewing a Private View
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Access the site by using the following web address:

Log in using an IPAD, MAC or Client Facing PC

Enter Gallery Username - Enter Gallery Password = Select Login

@tbook

USER NAME ‘

PASSWORD ‘

LOGIN

Enter PIN (this is issued when joining the company) = Select Login

PIN

LOGIN

fFD%N\ontfort



Select the Private Views icon = All your private views will be displayed = Select your Private View

ﬁ Orders Lx Settings 31 Slideshow:

¥ Home © Views

PRIVATE VIEWS

Forever Ago, Forever You Seasplashl
by Danielle O'Connor Akiyama

by Danielle O'Connor Akiyama v

Js PDF

Ij Print [ Email £ Price

Wherever You Go - So Too Does Love
by Danielle O'Connor Akiyama v

23

The below options are available:
» Create a slideshow
» Create a PDF
» Print imagery
» Email to client

» Display the price

€ DeMontfort

FineArt



Amending a Private View

To amend a private view = Open the Artwork Database - From the left hand pop up
menu, select the Private View icon = Find the client in the Customer Name field = Select the Artwork Number
correlating to that client = Private view details will be displayed

MRS X Private View Artwork x
YFilters | #¥Views | & PrintGrid = Wl Columns ] ) . .
£ Views = = Pnnt Grid M Columns &

Drag a column header and drop it here to group by that column

Customer Name Artwark ustomer Email Modified ¥ Modified By Image ETLEE L scription FHE

< leanne medley ) 3 06/09/2016 13:56|Petit jonathan | G«rd | Dﬂg and |—E:|E|E"|"ICE| DGI._Ig H:,"L'IE' < -
—— 1 N 17/08/2016 12:17|Petit jonathan 8O- Study
Alan Rickman 2 17/08/2016 11:30{Petit jonathan
4x2
Rocks 10 18/07/2016 08:19)Joe Sweeney
Orban 16 % 16 inches 6 17/07/2016 1152 Dana Fitzsimons o Duck Egg Study Doug Hyde & X
Attree 3 17/07/2016 11:26|Joe Sweeney A b /Y."-"
Budd ] 16/07/2016 14:10{Joe Sweens, <
& ¥ L
Kulvir 3 16/07/2016 10:30|Joe Sweeney
oy rai 1 e o

Landon 2 15/07/2016 14:59|Joe Sweeney Cow Portrait Study Doug Hyde ) Bl
Izaak 4 15/07/2016 14:29{loe Sweenay
Lisa 2 2 15/07/2016 14:00{loe Sweenay - - EYT

4 O 2 3 e n 50 v | items per page 1-50 of 142 items

. . w |[. . FaR
From the screen above, items can be deleted by selecting the icon, comments can be added by selecting the icon

€ DeMontfort
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http://gallery.theartbook.org/

Additional artwork can be added to the private view:

Find your required original or limited artwork item = Drag the item from the database to the private view screen

Private View Artwork

Originals
Y Filters L Views &= Print Grid = Price Labels Sef
Drag a column header and drop it here to group by that column

Image

Barcode ‘ Description ‘ Location | Artist | Width ‘ H

L3 Views | = Print Grid M Columns
Image Comments Description Artist
@ Dog and Hedgehog Study Doug Hyde
‘ @ b
4x2
Duck Egg Study Doug Hyde
Cow Portrait Study Doug Hyde

Retail Price | Friendly Description ‘ Artwork Style | Original Barc

25
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Checking Availability

An artwork piece is available if:
» You have filtered under ‘Retail Originals or Limited Editions’ and the artwork is displayed. Be aware that artwork

that is located on ships will take longer to come back

» You have selected ‘My Originals or My Limiteds’ and there is an ‘S’ displayed at the bottom right hand side corner
(irrelevant of colour)

An artwork piece is NOT available if:

» A ‘€' or ‘C’is displayed in the bottom right hand side corner

€ DeMontfort
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Colours and Codes

The Allocations Artbook Symbol/Letter is displayed on the right hand bottom corner of each image

Each Symbol has its own meaning, see below:

Artbook Symbol Allocations
£ Sale — Item is sold, not available to sell
Potential — A potential sale on item, not to be sold
Stock — Item available to sell
Exhibition — Item held back for exhibition, not to be sold
Exhibition — Focus - ltem held back for focus event, can be sold
Sale — Refunded — Item refund, available to sell
Commission — Bepoke item, not to be sold
Commission - Refunded — Bespoke item, not to be sold

ROV MM mMmwnv|o

Each Colour displayed along the strip at the bottom of the image has its own meaning, see below:

Colour Status

Grey (no colour) Available - In your gallery, available to sell
Green Stock - Item on the way to your gallery, available to sell
Orange Sold — Item sold, not available to sell

Despatched — Out of system, not available to sell
Returns — Item on return on stock rotation
Yellow Exhibition — Required for exhibition usage

€ DeMontfort
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Task - How Would You Find?
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» All available abstract limited editions, that are red and under £3000 — Save this view
» All available still life originals

» All available L.S Lowry industrial scene originals, less than £8,000

» All available large abstract originals, excluding Antonio Russo and Simon Kenny

» All available medium sized Danielle O’Connor Akiyama limited editions

> All available Jeffrey Pratt Originals at operations /HQ

» All available originals in your gallery

» All available Simon Kenny originals under 40 x 40 inches

> All available limited editions related to cars

fFD%Montfort



